
ZMMiK Laboratorium 4 - Statyczna Analiza Kompozytu
Warstwowego

1 Cel laboratorium
W ramach ćwiczenia laboratoryjnego analizie poddana zostanie płyta kompozytowa o wymiarach a =
600 mm, b = 400 mm, H = 8 mm. Płyta obciążona jest równomiernie rozłożonym ciśnieniem q =
0, 1 MPa. Zadanie zostanie rozwiązane przy pomocy dwóch modeli: warstwowego oraz trójwymiarowego.

Rysunek 1: Schemat modelowanej geometrii.

Przyjęto następujące reprezentatywne właściwości dla pojedynczej warstwy kompozytu jednokierun-
kowego na osnowie epoksydowej wzmocnionego włóknem węglowym. Właściwości inżynierskie w ukła-
dzie osi materiałowych warstwy (1-2-3):

E1 = 140 GPa = 140000 MPa (Moduł Younga w kierunku włókien)
E2 = 10 GPa = 10000 MPa (Moduł Younga poprzecznie do włókien)
E3 = 10 GPa = 10000 MPa (Moduł Younga w kierunku grubości)
ν12 = 0, 30 (Główny współczynnik Poissona)
ν13 = 0, 30 (Współczynnik Poissona)
ν23 = 0, 40 (Współczynnik Poissona)
G12 = 5 GPa = 5000 MPa (Moduł sztywności postaciowej w płaszczyźnie 1-2)
G13 = 5 GPa = 5000 MPa (Moduł sztywności postaciowej w płaszczyźnie 1-3)
G23 = 3, 5 GPa = 3500 MPa (Moduł sztywności postaciowej w płaszczyźnie 2-3)

Dla uproszczonych obliczeń w ramach Klasycznej Teorii Laminatów (KTL), przy założeniu płaskiego
stanu naprężenia w każdej warstwie, kluczowe są właściwości w płaszczyźnie: E1, E2, G12, ν12. Pozo-
stałe właściwości (E3, ν13, ν23, G13, G23) są istotne dla pełnej analizy 3D lub teorii płyt wyższego rzędu
uwzględniających odkształcenia postaciowe poprzeczne.
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1.1 Rozwiązanie analityczne
Punktemwyjścia do uzyskania rozwiązania analitycznego jest równanie różniczkowe ugięcia w przypadku
płyty specjalnie ortotropowej:
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Należy zwrócić tutaj uwagę, że zastosowanie tego równania dla analizowanego laminatu stanowi zna-
czące uproszczenie. Chociaż każda warstwa jest ortotropowa (E1 6= E2), ułożenie warstw pod kątami
prowadzi do anizotropowych właściwości giętnych całego laminatu (niezerowe współczynniki D16 i D26

w macierzy sztywności giętnej). Równanie 1 jest ścisłe dla płyt specjalnie ortotropowych, dla których
D16 = D26 = 0. W analizowanym przypadku laminatu anizotropowego współczynniki te są różne od
zera, stąd zastosowanie tego równania jest przybliżeniem. W rzeczywistości zachowanie płyty anizotro-
powej, uwzględniające pełne sprzężenia zginania ze skręcaniem, prowadzi do bardziej skomplikowanego
sformułowania, dla którego rozwiązanie jest bardziej złożone. Prezentowane uproszczone rozwiązanie
analityczne stanowi tylko punkt odniesienia w dyskusji dotyczącej dokładności dwóch różnych podejść
numerycznych - jednego bazującego na modelu warstwowym, który wywodzi się z równań teorii płyt i
powłok, oraz drugiego w pełni trójwymiarowego.

Dla płyty prostokątnej swobodnie podpartej na wszystkich krawędziach (taki typ podparcia określany
jest w literaturze jako simply supported albo oznaczany: SSSS), której ugięcie opisuje przybliżone równanie
(1), rozwiązanie można przedstawić w postaci podwójnego szeregu trygonometrycznego Naviera:
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Ostatecznie ugięcie wzdłuż linii środkowych płyty (y = b/2 oraz x = a/2) przyjmując tylko pierwszy
wyraz szeregu, dane jest:
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gdzie W11 dla analizowanego przypadku W11 ≈ 6, 755 mm.

2



1.2 Układ warstw laminatu kompozytowego
Analizowany laminat kompozytowy składa się z 8 warstw, każda o grubości h = 1 mm. Układ warstw jest
symetryczny względem płaszczyzny środkowej laminatu, a ich ułożenie zdefiniowane jest następująco:

[45◦/− 45◦/45◦/− 45◦]s

Takie oznaczenie rozumiemy jako sekwencję kątów orientacji włókien jak przedstawiona na rysunku
2 (licząc od dolnej powierzchni płyty, k = 1, do górnej powierzchni, k = 8):

Rysunek 2: Schemat ułożenia kompozytu.

1.3 Zadania
1. Przeprowadzić analizę z uwzględnieniem dużych ugięć: Analysis Settings→ Large Deflections→ On

w celu zbadania wpływu nieliniowości geometrycznej na wyniki.
2. Sprawdzić wpływ gęstości siatki na dokładność wyników.
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2 Właściwości materiałowe
1. Zaczynamy od dodania ortotropowego modelu materiału - Rysunek 3.

• 1: PPM na Engineering Data→ Edit.
• 2: Dodanie nowego materiału.
• 3: Dodanie ortotropii do materiału.

Rysunek 3: Dodanie ortotropowego materiału.

2. Dodanie właściwości materiałowych - Rysunek 4.

Rysunek 4: Właściwości materiałowe kompozytu.
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3 Model Warstwowy

3.1 Geometria i ułożenie kompozytu.
1. Geometrią modelu jest płyta o wymiarach 600× 400 mm w płaszczyźnie XY . Uwaga: we właściwo-

ściach podajemy grubość jako 8 mm.

Rysunek 5: Geometria modelu warstwowego.

5



2. Dodanie układu współrzędnych związanego z modelem - Rysunek 6.
• 1: PPM na Coordinate Systems→ Insert→ Coordinate System.
• 2: Dla wygody można zmienić nazwę nowo dodanego układu.
• 3: W definicji miejsca zaczepiena nowego układu należy wskazać cały model.

Rysunek 6: Dodanie układu współrzędnych.
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3. Dodanie warstw kompozytu - Rysunek 7.
• 1: PPM na Geometry→ Insert→ Layered Section.
• 2: Jako układ odniesienia wskazujemy układ współrzędnych z poprzedniego kroku. Offset -

Middle. Następnie klikamy na Layers→ Worksheet.
• 3: Dodajemy 8 warstw. W tym przypadku nie ma znaczenia, czy zaczniemy je dodawać jako

(+Z) czy (−Z).

Rysunek 7: Dodanie warstw kompozytu.

4. Ułożenie kompozytu zgodnie z zadaniem.

Rysunek 8: Wprowadzenie ułożenia kompozytu.
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3.2 Model MES
1. Siatka elementów skończonych - Rysunek 9.

• 1: Globalne ustawienia siatki.
• 2: Body Sizing dla całej płyty.
• 3: Gotowa siatka.

Rysunek 9: Siatka elementów.

2. Warunki brzegowe - płyta jest podparta w sposób statycznie wyznaczalny - Rysunek 10.
• A: 4 krawędzie (wszystkie) - przemieszczenie na kierunku Z = 0, reszta Free.
• B: 1 krawędź (wzdłuż osiXXX) - przemieszczenie na kierunku Y = 0, reszta Free.
• C: 1 krawędź (wzdłuż osi YYY ) - przemieszczenie na kierunku X = 0, reszta Free.
• D: ciśnienie 0.1 MPa działające na kierunku Z.

Rysunek 10: Warunki brzegowe.
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3.3 Wyniki analizy.
1. W modelu warstwowym wyniki wyświetlane są dla konkretnej warstwy. Warstwę można zmienić w

elemencie Scope każdego z wyników - Rysunek 11.

Rysunek 11: Naprężenia na kierunku x w pierwszej warstwie.

2. Przygotowanie ścieżek wzdłuż linii środkowych płyty - Rysunek 12.
• 1: Dodanie ścieżki: PPM na Model → Insert → Construction Geometry. Następnie dodajemy

dwukrotnie Path. Ścieżki zostaną określone przy pomocy współrzędnych początku i końca.
• 2: Definicja ścieżki na kierunku x.
• 3: Definicja ścieżki na kierunku y.

Rysunek 12: Przygotowanie ścieżek.
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• Schemat obu ścieżek - Rysunek 13.

Rysunek 13: Schemat obu ścieżek.

3. Wyniki prezentowane na ścieżkach to ugięcie w, czyli deformacja na kierunku Z.
• Ugięcie wzdłuż ścieżki x - wx.

Rysunek 14: Ugięcie wx.
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• Ugięcie wzdłuż ścieżki y - wy.

Rysunek 15: Ugięcie wy.

4 Model 3D

4.1 Geometria
1. Przed rozpoczęciem pracy nad trójwymiarową geometrią łączymy elementy danych materiałowych

pomiędzy modelami.

Rysunek 16: Połączenie właściwości materiałowych.
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2. Przygotowanie geometrii zaczynamy od narysowania jednej warstwy kompozytu, czyli prostokąta o
wymiarach 400× 1 mm w płaszczyźnie XZ.

Rysunek 17: Szkic pojedynczej warstwy w płaszczyźnie XZ.

3. Powielenie warstwy - Rysunek 18.
• 1: Zaznaczamy opcję Linear Pattern.
• 2: Wybieramy prostokąt z poprzedniego punktu.
• 3: Jako kierunek zaznaczamy oś Z.
• 4: Odpowiednio wypełniamy Pattern Type.
• 5: Na koniec zatwierdzamy operację.

Rysunek 18: Powielenie warstwy.

4. Skutkiem poprzedniej operacji jest przeniesienie nowych powierzchni do oddzielnych komponentów,
co należy naprawić - Rysunek 19.

• 1: W pierwszym kroku należy zaznaczyć z listy wszystkie powierzchnie (Surface), następnie
PPM na którąkolwiek→ Move to New Component.

• 2: Wszystkie 8 powierzchni musi znajdować się w jednym komponencie. Pozostałości z po-
przedniego kroku należy usunąć.

• 3: Ostatecznie lista powinna wyglądać w taki sposób.

Rysunek 19: Uprzątnięcie struktury modelu.
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5. Wyciągnięcie warstw - Rysunek 20.
• 1: Zaznaczenie wszystkich powierzchni.
• 2: Uwaga: należy zaznaczyć opcję No merge.
• 3: Jako kierunekwyciągnięcia zaznaczamy ośX. Następnie wyciągamywszystkie powierzchnie

na 600 mm.

Rysunek 20: Wyciągnięcie powierzchni.
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• Ostatecznie model powinien wyglądać jak na rysunku 21 i mieć w drzewie struktury jeden
komponent z 8 elemetami Solid.

Rysunek 21: Gotowy model 3D.
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4.2 Przypisanie ułożenia.
1. Dodanie układów współrzędnych - Rysunek 22.

• 1: Dodajemy dwa nowe układy współrzędnych.
• 2: Jako ich punkt odniesienia możemy zaznaczyć górną powierzchnię całego materiału (w

wypadku tego zadania współrzędnia Z układów nie ma znaczenia).
• 3: Po wprowadzeniu obu układów należy je obrócić względem osi Z odpowiednio o +45◦ i
−45◦. Uwaga: dla lepszej orientacji w kolejnych punktach warto zmienić nazwy układów.

Rysunek 22: Dodanie układów współrzędnych.

2. Grupowanie warstw.
• W celu ułatwienia zarządzania i przypisywania właściwości poszczególnym warstwom można

je pogrupować. W tym celu: zaznaczamy konkretne elementy z Geometry, następnie PPM na
jedną z nich → Group. W ten sposób dzielimy elementy na dwie grupy ze względu na ich
ułożenie: +45 i −45.

Rysunek 23: Grupowanie odpowiednich warstw.

15



• Warstwom z poszczególnych grup przypisujemywłaściowści - model materiału oraz odpowiedni
układ współrzędnych: 1 - warstwy +45◦, 2 - warstwy −45◦ .

Rysunek 24: Wprowadzenie parametrów warstw kompozytu.
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4.3 Model MES.
1. Ustawienia siatki - Rysunek 25.

• 1: Globalne ustawienia siatki.
• 2: Body Sizing dla wszystkich 8 warstw.

Rysunek 25: Ustawienia sitaki w modelu 3D.

2. Automatycznie wygenerowane kontakty mogą mieć zbyt duży „zasięg”, co często skutkuje zwią-
zaniem warstw, które nie przylegają do siebie. W tym celu należy zmienić ustawienia kontaktu -
Rysunek 26.

• 1: Zaczynamy od usunięcia wszystkich kontaktów wygenerowanych automatycznie.
• 2: W ustawieniach Contacts zmieniamy ustawienia automatycznego wykrywania kontaktu.
• 3: Generujemy nowe kontakty.
• 4: Sanity check: program powinien wygenerować 8 stref kontaktu (po jednym pomiędzy ko-

lejnymi warstwami). Wszystkim zmieniamy ustawienia według rysunku.

Rysunek 26: Modyfikacja kontaktu między warstwami.
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3. Warunki brzegowe są identyczne do tych wprowadzonych w zadaniu warstwowym, z tą różnicą, że
będziemy przykładać je do dolnych krawędzi - Rysunek 27.

• A: 4 dolne krawędzie - przemieszczenie na kierunku Z = 0, reszta Free.
• B: 1 dolna krawędź (wzdłuż osiXXX) - przemieszczenie na kierunku Y = 0, reszta Free.
• C: 1 dolna krawędź (wzdłuż osi YYY ) - przemieszczenie na kierunku X = 0, reszta Free.
• D: ciśnienie 0.1 MPa działające na kierunku Z przyłożone do górnej powierzchni.

Rysunek 27: Warunki brzegowe w zadaniu 3D.

4.4 Wyniki analizy 3D.
1. Podobnie jak w zadaniu warstwowym istnieje możliwość prezentowania wyników w konkretnej war-

stwie, z tą różnicą, że aby uzyskać taki obraz należy najpierw w Scope: Geometry zaznaczyć kon-
kretną warstwę.

Rysunek 28: Naprężenia na kierunku X w górnej warstwie.
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2. Przygotowanie ścieżek wzdłuż linii środkowych płyty - Rysunek 29.
• 1: Podobnie do poprzedniego zadania definiujemy dwie ścieżki wzdłuż linii środkowych płyty

przy pomocy dwóch punktów: początku i końca.
• 2: Różnicą w zadaniu 3D jest to, że należy jako współrzędna z podać środek płyty.

Rysunek 29: Ścieżki w zadaniu 3D.

• Ugięcie wx.

Rysunek 30: Ugięcie wx w zadaniu 3D.
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